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Introduction

This document has been compiled from the articles | started posting on my website since early 2009.

Be aware that the information you’ll find in this document might deviate from the environment you
are working in, processes that you will need to follow, or tools you have in place to perform specific
tasks (User management for example).

This information has been composed by me and a couple of colleagues. The reason for creating this
guide is for training and or reference purposes in a helpdesk environment.

There are a lot of companies out there that use lotus notes, but the usage and knowledge among
users and helpdesk staff is very limited. We found that the majority of information is presented on a
pretty high level, and is therefore not always accessible for everyone.

In this guide we tried to make the basic workings of the system and the troubleshooting of the most
common problems accessible for a wider audience.



Situation

The situation or environment | was working in consisted in a large, global company network,
containing several domino domains, and approx 60 Domino Servers.

We have employed tools for functions as user management and have hardly ever used the domino
admin client for this; neither have we used the domino Policy functionality to push certain settings
to users. You will therefore find that there is little information on those topics.

This document will start off with some basic information, like what the client and the server are and
what they are used for. After that, chapters will cover different parts of the client-server structure,
and the basic troubleshooting steps.



1 What is Lotus Notes — The Server

What is Lotus Notes?

Lotus Notes and Lotus Domino is a client — server database driven application that allows people to
share information.

The basic components of the Lotus environment are:
o The Lotus Domino Server

o The Lotus Notes client
o The Lotus Notes Database

The Lotus Domino Server

A Domino server is in the first place a database server: it stores and serves to the clients a number of
Notes databases. Notes databases consist of one single file, usually with the extension
“.nsf”. Example. Catalog.nsf, akoppe.nsf ....

All these Lotus Notes databases can be categorized as follows:

Notes administrative databases

These are used to manage and configure the Lotus environment i.e. the server itself.
Example:
o The Public Address book on the server, names.nsf, holds configuration information about all
servers and users in the Notes domain.
Log.nsf: contains the log of the server

Catalog.nsf: Contains all databases on the server

Standard Domino applications

These are the applications database running on the domino server.
The main examples are the Mail database and Domino Discussion databases or the address book.

Custom Domino applications

These are databases that are developed to serve a particular purpose.
Typical examples of Domino applications are:

o Documentation databases (e.g. Knowledge bases)
o Workflow applications (e.g. IXOS ...)



Apart from serving databases, the Notes server also runs some back-end processes to support for
instance mail routing, replication, calendaring and scheduling.

2 What is Lotus Notes — The Client

The Lotus Notes Client

Basics

The Lotus Notes client is the software being installed on your workstation. It allows you to connect
to your Domino server and therefore access your mail and other database applications. It also stores
your personal information such as your Lotus Notes ID file (your identification on the domino
infrastructure) and your personal address book. (names.nsf)

The Lotus client (the software) is usually installed on the hard drive of your PC under
Lotus/Notes/Data. All main resources being used by Lotus Notes are stored in that location.
Microsoft Windows and Lotus Notes are not related and do not interfere with each others, they are
totally independent.

Please note:
= 5 Lotus
= ) Motes For the Lotus Notes Client, names.nsf is your personal address
= D Data book and contains your personal information. Mail address,
) help connection documents, location documents.
() modems
() W32

For the Lotus Notes Servers, names.nsf is a general address book
containing all information about all users, all connections ...

Password authentication

Lotus Notes is a very secure platform.

Because simple user/password authentication is quite easy to break (you only need to obtain a user
name and a password), Lotus Notes security is based on certificates and public / private key
encryption.

This basically works as follows:

My lotus notes ID is AlexK/ES/ABITEOF

When | connect to the Lotus Notes server (authenticate to domino server), the server will
authenticate my name, and my certificate.

The Certificate is like a stamp on an identity card. The server | want to authenticate with actually
holds the original of this stamp in its Name and Address book, so he can compare it to the stamp |
presented him. When the two matches, he will believe that | really am AlexK/ES/ABITEOF, and will
allow me all the access | have been granted.

The stamps involved in Notes authentication are electronic signatures.


http://abiteof.com/wp-content/uploads/2010/05/lnDataFolder1.jpg

In that example, the stamps are AlexK, but also ES for Spain and ABITEOF as the company name.
All this information, my name and certificates are stored in the ID file. (akoppe.id)

The ID file

This ID file holds all my certificates and is protected by a password. Without a password, the ID file is
useless, and without an ID file, you cannot access anything in Notes. When | want to authenticate
myself, the Notes client will extract my user name and certificates from the ID file (and ask me for
the password to open that ID file if needed). The Notes password | enter is specific to the ID file |
use.

In practice, this means that if a Notes user forgets his password, you need to give him a copy of his
ID file, and the password that goes with that particular copy. In most Notes environments, it is
common practice for Notes administrators to keep a backup copy of every ID file that is created on a
central place. When a user forgets his password, the ID file he uses is removed, and replaced with
the backup copy. The user then uses the standard password to access that ID file (dummy file).

However, the standard procedure in the Domino Administration client will put the newly created ID
file in the servers’ Address book. This is not a very secure procedure, and a lot of customers will have
an alternative solution.

Workspace and bookmarks

Once you have been authenticated with your password and your ID file you get to the welcome page
or the workspace.

The welcome page in Lotus Notes is a page that contains dynamic elements you can customise.
Examples of elements are: A view of your mail file, a list of documents in a specific document library,
etc. The configurations of the elements of the welcome page are stored in the file Bookmarks.nsf

Figure 1. Lotus Notes Welcome Page

The workspace contains icons to all the resources you have been accessing.
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Figure 2. Lotus Notes Workspace
These icons are actually shortcuts to the different databases on different domino servers.

On the left hand side, the vertical bar contains bookmarks which are similar to the workspace icons.
You can easily locate your mail, your address book, your calendar and your most frequently used
databases. These bookmarks are, just as the welcome page configuration, stored in the file
bookmarks.nsf.



How-To — Recertification

Recertifying Expired Users

Use this procedure when a user ID has expired. There are two ways of undertaking this with both
procedures included here.

e  procedure 1 Update the ID file of the user locally.

e Pprocedure 2 Updates the expiry date of the certificate in the person document in the Domino
Directory. It uses the AdminP Process so there will be a delay while the task processes ( on
larger domains this can take quite some time). Use this procedure if immediate access is
required by the user and you can’t wait for AdminP (The Administration Process) to update
the certificates.

You will need:

e The Correct Administrative Rights on the Domino Network
e Access to the Domino Administrator Client

e The certifier ID file

e The user's Lotus Notes ID file and its password.

Procedure 1

1. Copy the users ID File (NotesUsername.id), which is located in the Notes folder, to a folder you
can access in your session.

- You can now access the ID file in Domino Administrator:

— @ Certification

Certify. ..

Cross Certify...

Cross Certify Key...

Edit Multiple Passwords...
Edit Recovery Information...
Extract Recovery Password...
Open Certification Log...

ID Properties...

> ¥ Registration

2. From the Domino Administrator client, select the server that the userison:

- File, Open Server, Type the server name (ex. HUBSERVER/ABITEOF), click OK.
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Select configuration tab then open the certification tab on the right-hand Tools bar.
The certifier ID file can usually be found in your DRIVE:\Notes\IDs\Certs folder.
Click on Certify and select the same certifier used to create the user.

Enter the password for the certifier.

It will ask you for the ID file to certify. Select the Users' ID file you have just copied to your
profile.

Then, enter the user's Lotus Notes password.

Server... I GBBATSNE/GB/I

Current certifier:  /Southampton/GE

Expiration date: |1 2/02/201412:47:12

Primary key: 13888 FT424 « o © wZC BJADE R14FE
Interational key: 1TYQCEDKL % =MD EUFAG F3463

Subiect name st w

Add... l Femove I

Password quality: Weak — —— J— Strong

Very weak password, crackable by
trial and error (3)

Certify I Cancel |

3. Add X time to the Expiration date and click on certify.

You might get some error message. You can confirm all went well by checking the Status bar at the
bottom of your Notes Administrator window (something like "Steve Homething/ES/ABITEOF has
been successfully recertified").

This has updated the certificate in the Domino Directory and updated the certificate in the Users' ID
file.

You need to copy the users' ID file back to the users Notes directory, overwriting the original.

Make sure the user closed notes, before overwriting his/her ID File, and if unsure if anything went
ok, please rename the original copy first.

The user should now be able to access Notes. If they can’t, then this will be a caching issue. Delete
the Cache.ndk (in v.5, Cache.dsk. In v.6, Cache.ndk) file, wait 15 minutes and try again.



Procedure 2

1. Using the Domino Admin client, ensure you are using server user’s home server because it
will mean the user will be able to access the server sooner.

2. Click on the People & Groups tab

3. Under the Domino Directory (the Address Book), click on the People view

E

Highlight the user in the view, (in this case: John Smith)

5. Open the document and make a note of his full hierarchical name after the first forward slash.
In this case: /ES/ABITEOF

6. Ensure that the server you are using matches the user’s server; you can confirm this by
checking the server address book.

7. Close the Person document

8. On the far right hand side of the Admin client, expand the People tool and click on Recertify

People & Groups IFiIes ISemev I“ i I.“ licati Ir‘ gurati l
@ Server: GBI SN0  Tools

Q@ Domino Directories [f Add Person ‘gsdhmnon %Dclmm. / O Peope

\} ¢ Address Book I 7
a @l |Name Telephone =] Regater...

&R Groups SanE
% Maikin Databases & f
(4] setup Profiles
L] Certficates |Smith
&R Deny Access Groups
Q) External Address Book

Smith

Smith

A People Smith
&3 Groups
#Z Mailin Databases & | |Smith » dj Groups

8l Cntein Diniitnn

You will then be asked for the certifier. It is very important that you use the correct certifier (The
same certifier that was used to create the user). For this user we require the /ES/ABITEOF certifier

The certifier ID file can usually be found in your Susers\Notes\IDs\Certs folder.

9. Select the correct certifier (.cid certifiers will not show in the pane unless you change Files of
type to All Files)

10. Enter the password for the certifier

11. Manually change the expiration date to today’s date plus X. There is no need to check
the” Edit or inspect”... box.



Renew Certificates In Selected Entries x|
Renew Certificates issued by:
/Southamptoe 8 50
New certificate expiraton date: _ﬂl

[12/02/201411:55:45

Only renew certificates that will expire before:

[ Edit or inspect each entry before submitting request

12. Click OK to complete

Processing Statistics ] x|

Entries selected: 1
Succeeded: 1
Failed: 0
Skipped: 0
Cancelled: 0

Details on entries which succeeded or failed are
recorded in the Certifier Log on server:

GBile " N 8o

[No information is recorded in the log for cancelled
or skipped entries)

The administration process will now update the person document in the Domino Directory. This
could take some time. When completed, the next time the user authenticates with the server, the
certificates will be updated automatically in the user’s ID file.
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3 Important Databases

Mail database

Internal Mail

Example. Alex k/ES/ABITEOF to Danny B/GB/ABITEOF

One of the most important or most used applications of Lotus Notes is e-mail.
Internal mail means mail from one Notes user to another and works as followed:

1. User A opens his mail database and creates a Memo for User B. When addressing the memo,
he can take advantage of Auto completion or look up the addressee in an address book.

2. When User A sends the mail, the Notes client will contact the server and transfer the mail to
it. The Notes server will look up User B in the Public address book to find User B’s Mail
server.

3. If that Mail server is the same as User A’s, the server will look up the Notes Mail file of User
B and deliver the mail to it immediately.

4. If both users are on different servers, the mail will be stored in the Mail.box on the server. At
scheduled times; the servers will connect to exchange mail.

External Mail

Example. Alex K/ES/ABITEOF (Alex_K@ABITEOF.com) to DannyBlack@hotmail.com

External mail (internet mail) is similar to internal mail.

The main difference is that the recipient is not in the address book, and is not on any Notes server in
the domain. The mail router will detect that the mail is destined to an external user (based on the
address format username@domain.com). The mail will then be delivered to a Notes server and
remain in the queue until being picked up and send out on the internet.

The Lotus Notes Databases

The most common database is the Lotus Notes e-mail Database.

Notes databases are basically a collection of Documents and when you open a Lotus a Lotus Notes
database, you are presented with a view of these documents. This is part of the database design.

Lotus Notes database are being designed and used as a tool to ensure all aspects of the business can
be stored on the Lotus Notes servers. Therefore a large number of applications like SAP are
communicating with Lotus Notes databases sending information to the servers and being viewed by
the users.

Catalog.nsf



A database directory is available on all Lotus Domino servers by simply opening the server and the
database filename Catalog.nsf. It contains all the databases currently being stored on the server,
their filename, their access control list and some other settings.

Access Control

All Lotus Notes databases user's administration is managed by the Access Control list.

The Access control list is available by > right click on the database icon > database > access control

Nicolag A BAT ISC L2 S
Fouquet | KNOWLEDGE § .\ i3C\EBD <
nCC_H" Gpen Doc
e—
Open Replcs »
j Open In MNew Window
: Fropares..
14T Fro, Replcation [l Access Control,,,
MMarge 27T b
nUKCC  pemaove From Workspace Copy s Link
New Copy...
Delet=...
Refrash Desion...
Replace Design...
Go To...
S0 To Agents

The Access control list of a database allows the following levels of access:

No access: if you are listed in the ACL of the database with No access, you have no access.
Reader: you will be able to read documents in the database. You will not be able to create or
modify any documents.

o Author: you will be able to read all documents, and you will be able to modify those
documents for which you re listed as an Author

o Editor: you will be able to read and modify all documents
Designer: you will be able to read and modify all documents + you will be able to modify the
design of the database (e.g. create / modify views)

o Manager: you will be able to read and modify all documents, modify the design and
additionally, you will be able to modify the Access Control List of the database, or delete it
altogether.

Access Control List to: Alex Koppelman ﬂ

#, Basics

B folea | PooPe \ ST - | J

T Holea Pecple. Servers, Groupe: o] retpe | =l
4 Defott- Zcosss  |No Access >
& Loa  Auarder Heposimam 150 Chertae 2

&) Advanced Lfcpo r
Cathedne Momagnany 150 Clenter I

& CC_Hatfieldd/ ServenClenter
[ LocaiDorranServers f
W Netes Adrevsratons I
(1) CtherDoranServers r
I Rgad publc documenta
[~ Yo pusic documents
vV Raghoate of copy documants

Foles V]

Ade | | |

Efecive Access

Full name

An Access Contral Lt (ACL) defines who can view and adt your databese.
Salact 2 name in the bt £ zae or sat the access asagred to the name.
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Example.

The Access Control list of your mailfile contains yourself as manager.

This list contains all groups allowed access to this database. Here are some examples:
Default-

On the right top corner User type is unspecified and access is no access.

ServerName / Local Domain Servers / OtherDomainServers

These are server access groups. To ensure for example, that your emails are being sent across the
company.

Notes Administrators

This is a person group (note the small icons displayed on the right of the groups names). These
groups manage access to the Helpdesk to my mailbox.

As you understand access to the Lotus Notes databases are given through a group or directly by
adding the person’s name to the Access Control list of the database. The preferred way is to add a
user to a group as groups are managed by the Server address book rather than grant him access to
the database as databases are sprayed over the network.

TIP: The "effective access" a person, server, or a group has to documents in a database
is not always apparent. For example, if there are two groups with different levels of
access to documents, and someone is a member of both groups, you may wonder what
access the person actually has. With one click, you can determine a person's effective
access to the documents.




How-To — Check Effective Access

The database access control list will give you enough information in most cases. If, however you
want to check a bit more thoroughly, check a users' or groups effective access:

=

Open the database that you want to check.
2. Choose File - Database - Access Control.
3. Click Basics and then click the "Effective Access" button.

4. Select the person, server, or group whose effective access you want to determine and then press
Enter or click the "Calculate Access" button.

o Access in the top left of the dialog box shows the selected name's effective database access
as determined by the database ACL.

o The checked boxes on the left side of the dialog box indicate the access rights for the
selected name.

o The "Groups" and "Roles" boxes on the right of the dialog box show all the individual and
group name entries and roles that could potentially control the selected name's access to
the documents in the database.

o "Full Access Administrator" is checked if the person, server, or group has full administrator
rights to the database. For example, if a person has this privilege, that person can delete the
database even if he or she does not have Manager-access to the database.



4. Troubleshooting View Errors

There are two main categories of error that are common to Lotus Notes — Configuration Errors and
View Errors. In this chapter we will be looking specifically at View errors.

There are several files which are needed for the correct functioning of the Lotus Notes Client. If they
become corrupted, or are poorly configured, database functionality is nearly always lost and the
Notes Client may stop working.

There are three that are “the usual suspects” for View errors.

o Bookmark.nsf: Contains your saved bookmarks and Welcome Page information.
Cache.ndk: Contains all design elements (the design note itself) cached from a server copy of
a replica.

o Desktop6.ndk: Contains the list of workspace pages and databases on those workspace
pages.

The Extensions:

o .NSF: Notes Storage Facility - Database - Holds Notes Data
.NDK : Notes Design Elements - Contains User Settings

o .NTF: Notes Template Facility - Database template used to create specific types of
database.

Troubleshooting — General Points

It is good practice when you delete or rename desktop6.ndk or bookmark.nsf to also delete
cache.ndk. However it is not necessary to rename or delete desktop6.ndk or bookmark.nsf
if you are removing cache.ndk.

If Bookmark.nsf or Desktop6.ndk is removed and a new file created the new file will be based on the
default settings and any changes the user has made are lost.

Bookmark.nsf

Errors with bookmark.nsf typically appear when Notes is trying to access a database, bookmark or
document and cannot. In most instances this occurs while starting the Notes Client or when opening
a database. This can produce a wide range error messages.

Unable to load frames content invalid or non existent
An error occurred while opening a window

The System Cannot Find the File Specified

Invalid or nonexistent document

Context Toolbar not found, Bookmark needs update
The linked document cannot be found in the view

O O O O O O



All the above error messages indicate that notes is trying to open something — a file, document,
frame etc — and cannot. This indicates that the bookmarked item cannot be found, possibly because
it has been removed or because the bookmark.nsf has become corrupted. In either case the
corrupted bookmarks need to be removed.

As the frameset and view information for bookmarked databases is cached in the bookmark.nsf file,
errors with the view of a database can also be caused by a corrupted bookmark file. Mails showing
as numbers rather than showing sender / subject information or the Inbox showing only as All
Documents are common errors caused by a corrupt bookmark.nsf.

Cache.ndk

Errors with the cache file can cause notes to behave in an erratic manner, crash or run slowly —
generally with no error message. When errors like this occur you should run Killnotes (a free
download from IBM), remove the cache and restart Notes. This may not always correct the problem
— especially if it is a poor performance issue — but cache errors can appear to be network errors.
Error messages such as “an unexpected network error has occurred” are typically caused by a
corrupted cache. Troubleshooting the cache file will help to identify if the problem is a network error
or not.

If notes will not restart after crashing you should run kill notes and remove the cache file.

! The cache file is responsible for the unread marks in databases so errors like a users read mail still
showing as read can be corrected by removing the cache.

The Cache file is generally held locally as it allows faster notes client performance.

Desktop6.ndk

Desktop6.ndk performs a similar role to bookmark.nsf but is responsible for the user’s workspaces
and databases held on it.

Errors with the workspace, such as missing icons or a missing workspace tab are likely caused by a
corrupted desktop6.ndk.

@ 3 If the desktop6 file is recreated any changes to the workspace the user made before
4459 . . . G .

the recreation will be lost — if possible it is advisable for the user to make a note of any

ng?éﬂ[ELE databases that may be lost as they can easily be added from the History Bookmark or

with a Catalog look up.

!If the user has a desktop5.ndk file in L:\Notes the default databases will be automatically added to
the Workspace. If not they are available from the Databases bookmark > Workspace Tab 1.

IQWMM[;MFW
| Databases | Workspace Tab 1 |
A T 7=

Several of these databases are “left over” from before the upgrade to Notes 6 so several of them are
Notes 5 databases — help etc — and are not needed.
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ﬁ ! If a database has been removed from the workspace and has been accessed within the last
seven days and the user isn’t sure of the path to the database it can be re-added using the
Bookmark History bookmark — the Icon is a Folder with a Pillar in front of it.

How-To - Clearing Bookmark.nsf

There are two ways to clear the bookmark.nsf

The first is to ask the user to close Notes, Go to Program Files\Notes (Notes Client installation
folder) then delete/rename bookmark.nsf — when they reopen Notes bookmark.ntf will create a new
bookmark.nsf file. This will be based on the default template and any changes the user has made to
their book marks will be lost.

By [ The second (less impacting), is to have the user left-click once on the bookmarks
wansie database on their workspace.

BAT Dec04
onLoca

They then have to hold [Ctrl + Shift] and select “Go To...” from the View tab.

|View Create  Actions Help
Refresh Unread Count

Arrange Icons
v Stack Replica Icons
v Show Unread
v Show Server Names

Agents
Design

Mo Views Ayailable

In the pop-up box that opens select (ByURL). This will open Bookmark database and display all
bookmarks.

@GDTO ﬂﬂ

Select the folder or view to open

E5 - Folders and Views - iﬂ 0K I
B[] Databases

(1 Favorite Bookmarks ﬂ‘
-1 More Bookmarks

=] (80l Bookmarks with Collations

E5] (&l Bookmarks)

B (ByURL)

Use Ctrl + A to select all and then press delete. After refreshing a confirmation box will appear
asking if you’re sure you want to delete. OK this and close the database.

Note: During this process it is very likely that you will get an error message — probably
“Object Variable not set”. This is normal as you are selecting a corrupted entry. You can OK
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The user should then go to their workspace and refresh — this will repopulate the bookmarks
database with all valid bookmarks in use. The user will not lose any changes that they have made.

If the corruption is only affecting one database you can delete only the bookmarks relating to that

database. Make a note of the Database Replica ID > Right-click on Database > Database >
Properties > 2™ Tab.

Database

Disk space: 43 MB % used

Documents: 478 Compact

Size

Activit Created: 04/04/2006 11:15:58 User Detail...
ctivi
E Modified: 19/04/2007 11:39:42

Replica ID: §D§m1?j
0DS version: 43

Then use the above method to show the bookmarks then use View>Search this view to locate the

bookmarks — in the search field enter the Replica ID without the colon ‘.. Select the bookmarks and
delete then refresh workspace as above.

If it isn’t on their workspace the bookmark database can be opened using Open Database> Local>
bookmark.nsf.
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How-To - Finding and Clearing Cache

When troubleshooting lotus Notes, in most cases it is advisable that you clear the client cache. This
to force the client to reload settings and views from scratch, instead of grabbing it from the cache
(where something corrupted might be stored).

The location of the cache file can be found in the notes.ini file in Program Files\Notes (Notes Client
Installation folder).

[Notes]

Preferences=546065521
SPELL _LANG=2057
KitType=1
AltNameLanguage=en
ContentLanguage=en-GB
WeekStart=2

XLATE CSID=52
Preference_en=,.,.,,.en-GB,.,
Region=en

Directory=L:'notes
WinNTIconPath=L:notestW32
T acatian=0ffce (Netzrarl-) 21048 ('NI=

It will normally be one of two places:
Program Files\Notes\cache.ndk or
%USERPROFILE%\Lotus\Notes\Cache.ndk

The user should browse to the correct location and delete the file. Be aware that this file can only be
deleted with the notes client closed.

When you remove cache.ndk it is good practice to also run killnotes especially if the issue with the
cache caused the Notes client to crash.

(Killnotes is a tool from IBM, that closes all open notes sessions and processes.)
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5 Template Issues

More serious errors with the View of a database may require that the design of the database be
refreshed or replaced. A further troubleshooting step prior to refreshing or replacing the design is to
update all views using

I [Ctrl + Shift + F9].

If none of the above steps have resolved the issue and you are sure that it is not a configuration
issue you should first refresh the design by right-clicking on the Database icon on your
workspace>Database>Refresh Design. You will be prompted for a server name; this should be the
home server (Where the database is located).
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Should this not resolve the issue you can replace the design using a very similar method. You need to
make a note of the current template, you can find this by right-clicking on the database
icon>database>properties. The information is in the settings tab - the fourth from the left.
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How-To — Replacing Template Design

As mentioned in the previous Chapter, to replace the design right-click on the Database icon on your
workspace>Database>Replace Design.
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You will again be prompted for a server; this should be the home server.

You will then be asked for a template — this should be the template that was showing in the
database properties.

ﬁ) Replace Database Design of mail\prenticeal.nsf ... [ E3

Template server
[GBBATGHE/BATCo | hes |
 Mail Archive[R6] BAT Junel5 &) Cancel |
Mail Template

SMSMai (RE) BAT June05
3 R5.0)
tk Armnour Temglate v2.1-3.09C v |

About., I AmouMalTemp_RE.ntf

[T Show advanced templates
¥ Inherit fuliee design changes
[T Hide tosmulas and LotusScript

You don’t always have to guide the user or take control of their PC to update the database design. As
long as the user has closed their Notes Client you can make the changes yourself with the database
opened from your own workspace.

! After refreshing or replacing the design
you should remove cache.ndk.

Bookmark errors tend to be characterised by elements of a view being inaccessible, this often
generates an error message and may prevent access to the database. Template issues in contrast,
while often making elements of the database fail to function, tend not to give an error. Errors like
mails disappearing from a view (assuming “show unread only” or a similar rule isn’t applied), buttons
or options such as Out Of Office or File to Armour are often Template Issues and can be resolved by
refreshing/replacing the design.
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6 Bookmark.nsf, Desktop6.ndk and
Cache.ndk

As mentioned in previous chapters, the above mentioned files are a very important part of each
Lotus Notes Client installation.

Bookmark.nsf

o lcons, notes, and user customized design elements (framesets and views) are cached in the
Bookmark.nsf file.

o The bookmarks are stored as documents so that multiple operations on bookmarks across
multiple clients can be resolved and not cause replication conflicts.

o History bookmarks are automatically purged after 7 days. These bookmarks represent every
database or document that the user has visited.

o The bookmarks can be viewed as either lists or as grid/icons — If using the “grid” view
bookmark.nsf works in conjunction with desktop6.nsf.

o Each view type operates on the same set of bookmarks, so operations (such as adds or
deletes) on one view of the bookmarks will automatically affect the other view.

Desktop6.ndk

o Continues to contain cached items pertaining to databases previously accessed from
bookmarks. Those cached items are primarily the list of design elements including their
NotelDs and UNIDs.

o Contains the list of workspaces and databases on those workspaces.

o The Desktop6.ndk is only used if a workspace is used — if a welcome page is being used and
databases are accessed using the catalogue lookup function or via bookmarks then
Desktop6.ndk is redundant.

Cache.ndk

o Contains all design elements (the design note itself) cached from a server copy of a replica.
For multiple replicas, only 1 copy of the design element is cached if they are the same.

o Also contains the unread journal which is used to coordinate unread information across
multiple replicas when accessed from the same client.

This is a very common issue. The unread count on the database Icon
on the users’ workspace shows an incorrect number of unread
documents. Deleting the Cache file, will rescan the unread items and
display these correctly.

If however, this does not work, ask the user if he could go to Edit ->
Unread Marks -> Scan Unread.

This should also scan the mail file for unread items, and will try to
display them correctly.
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o

The cache.ndk is created automatically whenever Notes starts, if the file does not already
exist. Therefore, if this file is deleted, it will be recreated the next time the Notes Client is
started.

The cache.ndk, by default, is located in the Notes data directory, unless a line in the notes.ini
file redirects it somewhere else.

Design elements (forms, sub forms, navigators, scripts, etc.) for a database are cached
locally in the cache.ndk. This speeds up access to commonly used design elements. When a
database is opened, it is determined whether the design elements need to be re-cached
from the database, based on an internal time stamp.



7. Notes.ini

By default, the Notes.ini file is located in the same folder Lotus Notes is installed in, and contains the
information you provide when you set up Notes, including the options you select in User
Preferences. Notes.ini may also contain information created by your administrator. This file gets
deleted when you uninstall Notes.

Most of the variables in the notes.ini file are accessible from the Notes client, and should not be
touched in the .ini file. However in some cases, for troubleshooting reasons it might be needed to

read or edit the .ini file.

Here are a couple of important values:
Directory=

This is the folder where the Lotus Notes Data Directory is located. This is an important line, because
a lot of clients use roaming profiles. This means that the Lotus Notes client is installed on the local
users’ computer, and the Data folder (containing the cache file, templates and other data, like
replicas of databases) somewhere on a server.

Cache=

This line allows you to specify a new location for the notes cache. This means, that even though the
Directory path is set to a specific location, the cache file can still be stored somewhere else.

(In some installations, the cache file is not located in the standard location, If you need to delete the
cache file and cannot find it, check for this line in the notes.ini file)

! It is also possible to completely rebuild the notes client by cleaning up the notes.ini file. The next
chapter will explain how to do that.

How-To — Rebuild the Lotus Notes Client

In this article we rebuild the Lotus Notes client. This is possibly the last troubleshooting action you
can perform before re-installing it. Therefore, make sure what you are doing and that all important
configuration files, are saved somewhere. (Test this first to see if this works well in your
environment!)

o Right click anywhere on the desktop and select new folder, name the folder backup.
o Click on start search for files or folders and search for the following files:

NAMES.NSF, DESKTOP5.DSK or DESKTOP6.NDK and NOTES.INI

Then hold control and select all of the files and select edit and copy to folder, browse to the backup
folder and click ok.



o Then select these files, (except the notes.ini) in the original notes data folder and delete
them, double click on Notes.ini file and delete all the text except for the first three lines:
[notes], directory= path-to-your-notes-data-folder, and KIT TYPE = 1

Ble [ot FMgmat Yew e

[motes )
Directorys=C:\Progras Files Lotus \votes' \Data (This should poimt to whatever the data directory 15)
KitTypes]

Then save the file.
o Now restart lotus notes. You will receive the following screen click on next.

The steps you’ll have to take from now on are those of a standard new set-up. So make sure you
have the name of the user, and the location of his or her mail-file.
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(Screenshot from a Lotus Notes V. 5 Client. This screen displays up till version 7)

o The next screen will prompt you for your name and domino server you would like to connect
to. Fill in the full name of the user, e.g. k, and un-tick the box next to | want to connect to a
domino server

o Now you will be prompted for the Lotus Sametime credentials. Here fill in the details.

Click next and in the screen that appears you will be asked for any other services you can
have notes connect to (Internet mail, Newsgroups, proxies, etc) Usually none of these are
being used.

o You now have Lotus notes ready for use, we can add back in the address book and the
desktop icons by selecting them in the backup folder, names.nsf & desktop5.dsk and copy to
folder lotus\notes\data overwriting the files that the client recreated.
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8 The Lotus Notes PERSONAL Address Book
(NAB)

When you address a message to a person, Notes looks in your Personal Address Book (NAMES.NSF)
for the person's mail address. If Notes does not find the information it needs there, it checks in the
Domino directory on your home server.

The Personal Address Book contains the following elements:

o Contacts: You can save information about people in contact documents in your Personal
Address Book.

o Groups: A place to Group contacts together. This can either be used for mail distribution
(Mailing lists), or access control.
Connections: Explained in more detail below
Locations: Explained in more detail below

Connection Documents

An important part of the address book is the Connections. The Connection documents store
information Notes needs to access a server, such as the server's full Domino name, Internet address
(IP), or telephone number. One server may have multiple Connection documents if you access it in
multiple ways, for example over the LAN at work and using a dialup modem from home.

Tip! If you know the IP address of the server for which you want a Connection document, choose
File - Database - Open, type the IP address into the Server field, and click Open. Lotus Notes
opens the server and automatically creates a Connection document for the server in your
Personal Address Book.

Location documents

The location document tell Lotus Notes where you are, what kind of connection you have to the
servers (TCPIP, Dial-up, ... ), where your mail-file can be found (locally or on the server), which server
you want to use as mail server, and some more settings. The location you are currently using is
displayed in the lower right corner of the screen, the left of the Inbox icon.

Home [Network Dialup] You can change it by clicking on the location, and then selecting a different

E?Q:J{qmes Direct Dialup] [} |5cation. You can modify the current location by clicking it and then select
“Edit Current”.

InternetB.

losﬁ:gg {B:ﬁ;ﬁ?oted] You can also select it from the menu File/Mobile and then select the

Travel (Notes Direct Dialup)|l appropriate option.

Edit Current... =

1 Intemets 3"

4

The default locations documents are:
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Home

When you are using a dial up connection and a modem

Office

when you are connecting from the office with a direct access to the server. This is the best
connection in terms of performance.

Island

when you are not connected at all to the network, this location document will tell Lotus
Notes not to send any mail or access resources.

Internet

when you are connected to the internet, Lotus Notes can connect to the Domino Servers ...
only if you have the necessary access and if the company allows access from the internet.



9 The Domino Directory, the Server’s Address
Book

Domino Diectory | Ol This address book, or directory contains all the users, certification but also

Yo = manages the entire group’s Access Control list. The domino directory is also

;",’;”;:;E‘;’, “= | called the General Address Book and is available on all Domino servers.

fteseisidi «=| When you open the general address book, you can manage users and groups
,‘;‘:ﬁ’.‘f" <t using the views displayed on the left corner of your screen.

=+=f Access to a Lotus Notes databases is given by adding people’s name to a
==1 group. This will be replicated all over the network.

Example:

View > Groups > Members by User and you can see all groups a user belongs to.

Group Access

All groups are given a group name, group type and a description. Therefore a group giving access to
a database can also be a mailing group. All groups can be edited with administrator rights, a button
EDIT is displayed on the user’s screen.
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10 Replication and Archiving

Replication is one of the most important, yet least understood features of Lotus Notes/Domino.
Replication is the process of keeping different copies (Replicas) of the same database synchronized.

That applies to both the design (the look and colours, the forms you fill out, the views that display
the documents, the security, etc), and the information (documents) inside the databases.

So what does that mean?
Think of one of the Lotus Notes databases you use at work.
That database most likely resides on more than one server in your company.

Perhaps employees in Canada access it on Server A, while
employees in France access it on Server B, Germany uses Server C,
and people in Japan use Server D. You want everyone to see the
same information.

So when you create a new document in that database, or edit
¥ (update) and existing document, or even delete a document,
replication is the Domino process that makes sure those changes
are also reflected in the other databases.
Replication occurs on a schedule that your Domino Administrators set-up.

For important databases this schedule maybe frequent, such as every 10 minutes, or 5, or even 1.
Other databases which are not as "time sensitive" may replicate only once a day.

A "local replica" of a database allows you to access Notes data stored on your own computer, rather
than accessing it on a server across a network connection. This "local access" results in much
quicker access times, and most importantly means you can still work when you don't have a network
or internet connection. If you are in a meeting room without network access, or on a train/airplane,
or at a customer site where you can't access your own company's servers.... with Lotus Notes you
can still have all the information you need at your finger tips!

! Replication keeps the local databases "synchronized" with the versions on the server.

In short these are the (dis-)advantages of creating local replicas of databases:

Type of Advantages Disadvantages
Database
access
Server- o No additional Notes client o Increased network utilization.
based configuration. o Performance impact by heavy network
o Information in mail file is loads.
always current. o Slower access over dial-up and poor
o Easier mail-file maintenance. network connections.
o Messages and notifications o Loss of productivity due to server
are processed without delay.
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o Can use Notes client, Domino
Web Access, and other
clients to access mail.

outages.

Local
replica-
based

o Access to mail when the
server or network is not
available.

o Increase in performance
when accessing mail.

o Less impact on the network.

Additional configuration of the Notes
client.

Reliance on the Notes client.
Additional user training.

Requires additional help desk resources
to troubleshoot problems.

Requires sufficient PC disk space.
Increased risk of data theft.

Possible time delay in sending and
receiving information.

Out-of-date information in server-
based replica when accessing with
another client (for example, Domino
Web Access).

Database links, view links, and doclinks
may not work properly when
disconnected from the server.

No lookups of free time when
scheduling meetings.

A very common problem experienced with replication is the replication or save conflict.

Troubleshooting Replication

There are a several things that can go wrong in replication process. Most of these have to do with
the replication being set-up wrongly. Going through the settings with the user, preferably using
remote control, you can easily see why certain replication process fails.

Another easy fix is to clear the replication history. This is like deleting a cache file that saves the
elements previously replicated. This means that on the next time it replicates it will not skip the
elements previously replicated and make a complete replica. To do this, follows these steps:

ukwnN

Open the Replicator page and right-click on local mail file Replicator tab or the line with

user's name and envelope icon.

Select Replication History, and click on Clear.

Click yes, and then exit out of the mail file.
Click on Start, to run the replication.

Verify whether or not new messages are now in the Inbox.

e If they are, everything worked.

e If they are not, have the client clear the Replication History on the server copy of the

mail file as well.




The last resort would be to create a new local replica. In the windows explorer find the replica of the
database, and cut-paste it into another location (desktop for example). Now create the replica
following the next steps.

How to Create a Local Replica

To create a new full replica
1. Do one of the following:

o Open the database you want to create a replica for, and from the menu, choose File -
Replication - New Replica.
o Dragthe database's bookmark to the Replicator icon on the bookmark bar.

2. If the database you're creating a replica for is on a server, Notes opens the Create Replica for
Database DatabaseName dialog box (where DatabaseName is the title of the database). Do one of
following:

To create the replica locally in the data directory (the default), proceed to step 4.
To create the replica on a server, in the Server list, select or enter the name of a server on
which you want to create the replica, and click OK.

o Modify the file name for the replica in the "File path" field. To specify a file path, click the
folder icon and browse to the directory on the server where you want to save the replica.

3. If the database you're creating a replica for is local, Notes opens the Overwrite Replica for
Database DatabaseName dialog box. Do one of the following:

o To create the replica on a server, in the Server list, select or enter the name of a server on
which you want to create the replica, and click OK. Lotus Notes changes the title of the
dialog box to Create Replica for Database DatabaseName.

o To create the replica locally, modify the file name for the replica in the "File path" field. To
specify a file path, click the folder icon and browse to the directory in your operating system
where you want to save the replica. Modifying the file name in any way will prevent
overwriting if the original database is local, but the title of the dialog box changes only if you
enter a different file path.

4. (Optional) Click "Replica Settings" and do any of the following:

o (Optional) Select "Encrypt the replica using" and choose an encryption type (Strong, Simple,
or Medium) from the list.

o (Optional) To improve full-text searching of this replica, select "Create full text index for
searching.” To save space on your hard drive, deselect it.

o (Optional) To use the same security settings for the replica as for the original database, leave
"Copy Access Control List" selected. To use different settings, deselect it. The check box is
available only when you are not the database manager and the database's ACL is not set to
enforce a consistent ACL across all replicas.

o (Optional) To create the new replica when you click OK, regardless of the setting in your
replication preferences, leave "Create Immediately" selected. To wait until the next
scheduled replication, deselect this option.



o (Optional) To customize settings for this replica, such as whether to replicate to or from the
server (or both), a schedule, and which documents in the database to replicate, click More

Settings.

5. Click OK.



11 Updall and Fixup, ways to fix corrupted
databases

If you encounter database corruption in a database (For example: "This database cannot be opened
because a consistency check of it is needed"), you can use any of these methods to try to fix the
problem.

Because corruption is much less of an issue for logged databases, these methods are primarily used
for solving corruption problems in unlogged databases.

Run Fixup to fix corrupted views and documents.

Run Updall to fix corrupted views and full-text indexes; if a corrupted view is the problem,
try Updall before trying Fixup.

Run Compact with the -c option to fix corruption problems that Fixup doesn't correct.

Press SHIFT+F9 to rebuild one view; press CTRL+SHIFT+F9 to rebuild all views in a database.
Create a replica of the database.

UPDALL:

Updall options
You can use any of these methods to run Updall on a server:

o Task - Start tool in the Domino Administrator - use this method if you don't want to use
command-line options.

o Load Updall console command - use this method if you're comfortable using command-line
options or if you want to run Updall directly at the server console when there is no Domino
Administrator running on the server machine.

o Program document that runs Updall - use this method to schedule Updall to run at particular
times.

o Run Updall on a Win32 platform - use this method if you are unable to run Updall at the
server console. This method requires that you use the "n" prefix, for example, nupdall - R.

When you use these methods, you can include options that control what Updall updates. For
example, you can update all views and not update any full-text search indexes.

The following tables describe the options you can use with Updall. The first column describes the
option names as they appear in the Task - Start tool. The second column lists the equivalent
command-line options that you use when you use a console command to run Updall and when you
schedule Updall to run in a Program document.

Use this syntax when you use the Load updall console command:

Load updall databasepath options

For example:

Load updall SALES.NSF —F



You can specify multiple options -- for example:

Load updall -F -M

Updall — Basic options

Option in Command-line Description
Task - Start  |option
tool
Index all databasepath "Only this database" updates only the specified database. To
databases update a database in the Domino data folder, enter the file
name, for example, SALES.NSF. To update databases in a folder
Index only within the data folder, specify the database path relative to the
this database data folder, for example, DOC\README.NSF.
or folder
"Index all databases" (or no database path) updates all
databases on the server.
Update this |database - Updates a specific view in a database. Use, for example, with -R
view only Tviewtitle to solve corruption problems.

Updall - Update options

Option in Task - Start tool Command- | Description
line option
Update: All built views -V Updates built views and does not update
full-text indexes.
Update: Full text indexes -F Updates full-text indexes and does not
update views.
Updall - Rebuild options
Option in Task - Start Command- | Description
tool line option
Rebuild: Full-text indexes |-X Rebuilds full-text indexes and does not rebuild views. Use to
only rebuild full-text indexes that are corrupted.
Rebuild: All used views -R Rebuilds all used views. Using this option is resource-
intensive, so use it as a last resort to solve corruption
problems with a specific database.

Updall - Search Site options

Option in Task - Starttool |Command- |Description

line option
Update database -A Incrementally updates search-site database
configurations: Incremental configurations for search site databases.




Update database -B Does a full update of search-site database
configurations: Full configurations for search site databases.

FIXUP:

A) When running from Domino Administrator:
Use this method to run Fixup on one or a few databases.

From the Domino Administrator, select the server that stores the databases you want to run Fixup
on. If the Domino Administrator does not run on a server, you can select local to run Fixup on
databases stored on the client.

Click the Files tab.

Select the databases on which to run Fixup.

In the Tools panel at the right, select Database - Fixup.
(Optional) Select options to control how Fixup runs.
Click OK
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B) When running from the Console:

Open up the domino server and get to the domino server console. In there, type the following
command:

Load fixup -F DBFILEPATH.nsf

If you use Microsoft remote desktop to connect to the domino server, make sure you run the
mstsc.exe /console command. If you do not, you will not e able to see the running console.

Command Line Options:

Fixup options in |Command-line | Description
Fixup tool and equivalent
Task - Start tool

Fixup all databasepath |"Fixup only this database or folder" runs Fixup only on a
databases specified database or all databases in a specified folder. To run
Fixup on a database in the Domino data folder, enter the file
Fixup only this name, for example SALES.NSF. To run Fixup on a database or
database or folder databases in folders within the data folder, enter the path

relative to the data folder. For example, to run Fixup on all
databases in the DATA\SALES folder, specify SALES.

Report all -L Reports to the log file every database that Fixup opens and
processed checks for corruption. Without this argument, Fixup logs only
databases to log actual problems encountered.

file

Scan only since When you run Fixup on a specific database, Fixup checks only
last fixup documents modified since Fixup last ran. Without this option,
Fixup checks all documents.



http://www.codestore.net/help/help6_admin.nsf/f4b82fbb75e942a6852566ac0037f284/579be9269e2cb49585256c1d0039b81a?OpenDocument#84264339229248453_

Scan all -F When you run Fixup on all databases, Fixup checks all
documents documents in the databases. Without this option, Fixup checks
only documents modified since it last ran.
Note To specify this option using the Fixup tool, deselect "Scan
only since last fixup."
Perform quick -Q Checks documents more quickly but less thoroughly. Without
fixup this option, Fixup checks documents thoroughly.
Exclude views -V Prevents Fixup from running on views. This option reduces the
(faster) time it takes Fixup to run. Use if view corruption isn't a problem.
Don't purge -N Prevents Fixup from purging corrupted documents so that the
corrupted next time Fixup runs or the next time a user opens the database,
documents Fixup must check the database again. Use this option to salvage
data in documents if the corruption is minor or if there are no
replicas of the database.
Optimize user -U Reverts ID tables in a database to the previous release format.
unread lists Don't select this option unless Customer Support recommends
doing so.
Fixup transaction- |-J Runs on databases that are enabled for transaction logging.
logged databases Without this option, Fixup generally doesn't run on logged
databases.
If you are using a certified backup utility, it's important that you
schedule a full backup of the database as soon after Fixup
finishes as possible.
Fixup open -0 If you run Fixup on open databases, Fixup takes the databases
databases offline to perform the fixup.
This is the default if you run Fixup and specify a database name.
Without this option, when you do not specify database names,
Fixup does not run on open databases.
Fixup -Y Runs Fixup on databases in subfolders (subdirectories).
subdirectories
Don't fixup -y Does not run Fixup on databases in subfolders (subdirectories).

subdirectories

Most of the information in this chapter is coming from the IBM Domino 6/7 Forum.




12 Out Of Office

The Out Of Office message is an auto responder to any incoming email, advising the sender of the
email, that the recipient is currently not in the Office. The agent that sends out the emails also sets
the users calendar as busy during these days.

Troubleshooting the Out of Office

The most common problem is that the agent does send out any mails while the agent is set to
enabled, or the agent has been disabled and the user keeps getting reminders that he should disable
it.

The most important troubleshooting step is to check on the server if the agent is enabled, by the
correct user, on the correct server, and if the user has the correct access level (should be at least
editor). This is how you can check that:

Is the agent enabled?

Check whether or not the agent is enabled. The screenshots below shows how the Out of Office
agent appears in the agent list when enabled or disabled:

Out of Office agent enabled
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Out of Office agent disabled
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Questions to consider while troubleshooting

o Is the Out of Office agent not working for just one person, or for everyone? If it is not
working for everyone, it is more likely to be a mail configuration issue.

o Isthe agent signed by an ID other than Notes Template Developers? If it is signed by another
ID, this means some operations have been performed to change the agent. Is it a signature
that you expected? (Server for Editor level users, mail owner for Designer/Manager users). If
not, check the access level of the signer.

o If the agent is supposed to be running now, is the agent in the agent manager schedule
queue?

o Are there any errors on the server console?

If the user has Editor Access, are there requests issued on the user’s behalf in the AdminP
task?

Is the agent scheduled to run on the right server?

Has the user been recently renamed?

o Did the user’s ACL recently change? If the user's access used to be a Designer and then was
changed to Editor, the Out of Office agent may be signed by an ID that causes AdminP to fail.
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13 Mail Rules

This is quite a simple one. You’d be surprised however how many people struggle with this in Lotus
Notes, especially people who are used to the Microsoft way of things.

You can use mail rules to have Notes act automatically on new messages you receive that meet
certain conditions. For example, you could create a rule that checks for messages from a certain
sender or that contain a certain subject and have Notes automatically move the messages to a
certain folder, send copies of the messages to someone, or delete unwanted messages before you
ever see them in your Inbox.

Notes stores the mail rules you create in the Rules folder in your mail database. You can go there to
add new rules as well as work on the ones you've created. For example, you can edit rules, change
their order so that one rule has priority over another, and turn them off when you don't want to use
them, or delete them entirely.

How do I create "rules" in Lotus Notes to filter out some unwanted mail?

You can use mail "rules" to have Notes act automatically on new messages you receive that meet
certain conditions. For example, you could create a rule that checks for messages from a certain
sender or that contain a certain subject. If a received message fits any of the rules you have
specified, you can have Notes automatically move the message to a certain folder or delete it
altogether.

Notes stores the mail rules you create in the Rules folder in your mail database. You can go there to
add new rules, as well as to work on or edit the ones you've already created.

How to create a mail-rule

To create a new rule, do the following:

1. Open your mail database and click on the 'Rules' folder.

Click "New Rule."

3. Under "Specify Conditions," select a part of messages to check (such as "sender" or
"subject"), select a state (such as "contains" or "is"), and type the criteria to check for (such
as the name of a certain person or a certain word). For example, you could select "sender,"
select "contains," and type Alice to filter all messages sent to you by Alice French, Alice
Stearns, and anyone else named Alice. Or you could select "Size (in bytes)," select "is greater
than," and type 2000 to filter all messages sent to you that are greater than 2000 bytes in

N

length.

4. Click Add.

5. Under "Specify Actions," select "move to folder," "copy to folder," "change importance to,"
or "delete."

6. If you selected "move to folder" or "copy to folder," click "Choose Folder" and select a
folder. If you selected "change importance to," select an importance level.

7. Click "Add Action."

8. Click OK



14 Interesting Resources

Because the documents | wrote in for the Lotus Notes troubleshooting guide do not cover
everything, or far from that, cover only a few common problems and details about the Lotus notes
infrastructure, here are some links to handy troubleshooting resources:

e |BM - All Lotus Troubleshooting Links

e |BM — Notes/Domino 6/7 Forum - This is not an easy place to find stuff, use And/Or in your
searches to find relevant information.

e |BM — Lotus Notes and Domino Wiki

e NFSTools.com

e Lotusdomino.com - A huge collection of links and resources.

e AdmiNotes

Sources and Thank-you’s

A lot of information in the document is coming from Official IBM Sources. If you look hard enough,
you will find an extensive source of information in the form of forums, PDF documents and blogs of
people that work with IBM.

Also I'd like to thank the colleagues that helped me document all these things. Mainly AP, who, if
he’d ever read this, would directly recognise some of the material ;)
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